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PFS:Publisher Commands Menu

File Contains commands for opening, saving and printing PFS:Publisher files 
(publications).

Edit Command items that allow you to edit text and manipulate the placement and 
position of objects.

View Commands that allow you to specify how you would like a publication to appear 
on the screen.

Page Commands that allow you to add, remove, manipulate, and move around the 
pages of your publication.

Text Commands that allow you to determine the format, placement, and appearance 
of text within your publication.

Object Commands that let you create, edit, and position objects such as picture and text 
frames, and items drawn with the drawing tools, within a publication.

Master Commands that allow you to change the appearance of the Master Pages.

Insert Commands that allow you to add items such as page numbers, date and time 
headers and footers to your publication.

Utilities Commands that provide a number of supplementary services for your document, 
such as table of contents and index creation, spell checking, thesaurus, and a 
picture catalog for frequently used art.

Window Commands that offer options for arranging publication windows and icons on 
your screen when working with more than one publication at a time.

Help Commands that provide you with information on using Publisher and Windows.



File Menu Commands

New... Starts a new, blank publication, and allows you to choose the template you will 
use to create the new publication.

Open... Opens an existing publication.

Save Saves the current publication as a publication file using its current name.

Save As... Saves the current publication under a new name or as a publication template.

Import Text... Imports the text from a file into the current publication.

Export Text... Saves the current story or selected text in either ASCII or Rich Text Format 
(RTF).

View Pers. Catalog... Allows you to view small representations of all the templates in the default 
template catalog.    The Personal Catalog is specified in the View Preferences 
dialog box.

Page Setup... Allows you to specify the publication page size and orientation.

Print... Prints the active publication.

Printer Setup... Allows you to select the printer you will use to print publications.

Exit Publisher Closes all open publications and exits the PFS:Publisher program.



Starting A New Publication

To start a new, blank publication, select File, New (Alt F, N) from the menu.

Keyboard shortcut: Ctrl+N

Selecting this command will bring up a dialog box with the following:

Use Template Allows you to open a copy of a previously created template for 
creating your new publication.

View Allows you to view a small representation of a selected template. You
can also use the View button to see representations of all the 
templates in a template catalog, and select one of the templates for 
use.

New Window Check this option if you already have an open publication and you 
want Publisher to open a new publication in a new window (this is the
default). Up to 16 windows can be open at one time. If this option is 
not checked, Publisher opens the new publication in the current 
publication window and closes the current publication in that window.
If the current publication has not been saved and you choose to use 
the current window, Publisher asks if you wish to save it before 
opening the new publication.

Save Default Select the Save Default button if you want to specify a template other
than the Normal template as the default for all new publications.    
When Publisher is started, the newly selected default template is 
automatically opened.



Opening An Existing Publication

To open an existing publication, select File, Open (Alt F, O) from the menu.

Keyboard shortcut: Ctrl+O

Selecting this option brings up a dialog box which displays the following:

File Name Enter the name of the file you want to open in this area. You may 
also type the file name using wildcard characters, use the default 
*.pb1, or enter the file type in the Type text box and click on OK.    
Then, select the drive and directory from the Drive and Directories 
list boxes, and select the file name from the File Name list.

List Files of Type Select the type of file you want to open.    If you are opening a 
publication, select Publication    (.pb1).    If you are opening a 
template, select Template (.tm1).

Directories / Drives Select the directory and drive of the file you want to open from the 
Directories and Drives list boxes and click on OK. All files with the 
name or type you specified appear in the File Name list. Select a file 
from the list.    If the file you want is not in the list, specify a different 
drive or directory.

New Window Check this option if you want Publisher to open the publication into a 
new window without closing any currently open windows.    This 
option is checked by default. Up to 16 windows can be open at one 
time.



Saving A Publication

Save the current publication using its current name by choosing File, Save (Alt F, S) from the menu.

Keyboard shortcut: Ctrl+S

To save a publication under a new name or as a publication template, use the Save As... command.    To 
save the file in another format, use the Export Text command.



Save Publication As...

To save the current publication under a new name or as a publication template, select File, Save As... (Alt 
F, A) from the menu.

Keyboard shortcut: F12

Selecting this item causes a dialog box with the following to be displayed:

File Name Enter a name for the publication or template.    The default file name 
extension for publications is .pb1 and is automatically added to the 
file name you enter.

List Files of Type Select the format type in which the file will be saved.    Publisher can 
save files as either a Publication (.pb1) or a Template (.tm1).

Directories / Drives Select the drive and directory where you want to save the file.    Click 
on the down arrow next to the Drives list box to display a list of 
available drives.    Select a drive from the list; and then select a 
directory from the list that appears in the Directories list box.

Save You can choose to save either the entire publication (Publication) or 
a selected portion of text (Text Selection). Publication is the default. If
no text is currently selected the Text Selection option is greyed out.

Add to Template Catalog Allows you to save the file as a template in a previously defined 
template catalog.    When you select this option, a list of previously 
defined template catalogs appear in this list box.    Select the 
template catalog to which you want to add the new template.



Importing Text

Publisher allows you to bring documents created in many popular word processors into a publication. To 
import the text from a file into a text frame in the current publication, select File, Import Text (Alt F, I) from 
the menu.

The Import Text command imports only text; it does not import pictures or drawn graphics. The text is 
imported into a text frame in the current publication starting at the current cursor position. If no text frame 
exists in your publication, or if the cursor is not positioned in a text frame, the Import command is greyed 
in the File menu.

Publisher can import text files in the following formats:

Ami Professional 1-1 & 1-2
ASCII (.txt)
Microsoft Word 3.x, 4.0 and 5.x
Microsoft Word for Windows
PFS:First Choice 1.0, 2.0, 3.x
PFS:WindowWorks Format
PFS:Write 2.0
PFS:Write Ver C
Professional Write 1.0, 2.x
RTF (Rich Text Format)
WordPerfect 4.1, 4.2, 5.0 and 5.1
WordStar 3.3x, 3.45, 4.0, 5.0, 5.5 and 6.0
WordStar 2000 3.0 and 3.5
WordStar for Windows

Selecting the Import Text option brings up a dialog box with the following:

File Name Enter the name of the file you want to import here.

List Files of Type Select the type of file you are importing.    To display a list of the 
supported file types in the selected directory, click the down arrow to 
the right of the text box.

Directories / Drives Select the drive and directory of the file you want to import and click 
on OK. All files with the name or type you specified appear in the File
Name list.



Exporting Text

To save the current story or selected text in either ASCII or Rich Text Format (RTF), select File, Export 
Text (Alt F, E) from the menu.

If there is no text in the current publication, the Export Text command appears greyed in the File Menu. 
The Export Text command saves text only; it does not save pictures or drawn graphics.

Selecting this option displays a dialog box with the following:

File Name Type a file name for the exported text.    A default file name extension
is not added for ASCII files; .rtf for Rich Text Format files.

List Files of Type Select the format type of the exported file.    Publisher can export text
into either ASCII or RTF format.

Directories / Drives Select a drive and directory for the exported file.



Viewing A Personal Catalog

To view small representations of all the templates in the default template catalog (See Preferences under 
the View menu), select File, View Personal Catalog (Alt F, V) from the menu.

Keyboard shortcut: Shift+Ctrl+V



Page Setup

To set up a publication's page size and orientation, choose File, Page Setup (Alt F, G) from the menu.

This option also allows you to define whether the publication will have facing pages, and where to place 
page margin guides.

Page Choose from three page size options:    Letter (8.5 x 11 inches), Legal (8.5 x 14 
inches), and Custom. To specify a custom page size, choose Custom and enter 
page dimensions for width and height. Publisher allows a maximum page size of  
22 x 22 inches.

Orientation Choose Portrait for a top to bottom (vertical) orientation. Choose Landscape for a
side to side (horizontal) orientation.

Layout Check this option if your publication will have facing pages (left and right) and will
therefore require separate Master Pages.

Page Margin Guides Allows you to determine where page margin guides will be placed. They do not 
determine the printable area of the page, but are meant to act as margin 
guidelines when placing objects on the page. If facing pages is turned on, 
"Inside" is the right margin for an even page and the left margin for an odd page .



Printing A Publication

To print the active publication, select Print from the File menu (Alt F, P).

Keyboard shortcut: Ctrl+P

Publisher prints your publication on the printer you selected in the Printer Setup dialog box. After selecting
this option a dialog box with the following will appear:

Copies Enter the number of copies of the publication you want to print.

Pages You can print the entire publication (All), or a range of pages. To print a range of 
pages, choose "Range", and enter the starting and ending page numbers in the 
From and To boxes.



Printer Setup

Select File, Printer Setup (Alt F, R) to choose the printer you will use to print publications.

Publisher uses the default printer specified in the Windows Control Panel unless another printer is 
chosen. The selected printer should be the printer on which you plan to print the final copy of the 
publication.

Use the Setup... button to change the selected printer's default settings.



Exiting PFS:Publisher

To close all open publications and exit the PFS:Publisher program, select File, Exit (Alt F, X) from the 
menu.

Keyboard shortcut: Alt+F4

If you select this option and have not saved your most recent changes, Publisher will ask if you want to 
save them.



Edit Menu Commands

Undelete Reverses the last deletion you made using the Backspace or Delete key. 

Cut Removes selected text or object from publication and places it on the Clipboard.

Copy Places a duplicate of the selected text or object on the Clipboard.

Copy to Master Page Copies the selected item, or group of items to the master page associated with 
the page of the publication you are working on.

Paste Places the contents (text only) of the Clipboard in the publication at the current 
cursor position.

Paste Object Places the contents of the Clipboard (objects only) in the publication at the 
current cursor position.

Paste Link Places the contents of the Clipboard (OLE objects only) into the publication at the
current cursor position.

Select All Allows you to select all the text in the current story.

Search Searches through the entire publication for text you specify.

Replace... Searches for occurrences of text and substitutes it with replacement text.

Repeat Last Repeats the last Search or Replace, using the same specified text.

Links  Allows you to change the type of OLE link for a linked object.

Object Starts an OLE server application to edit an OLE object in a publication.



Undelete

Undelete lets you reverse the last deletion you made using the Backspace or Delete key. To use this 
command select Edit, Undelete (Alt E, U) from the menu.

Keyboard shortcut: Alt+Backspace

This command does not undo other actions such as Cut. Undelete is unavailable if no text or objects were
deleted using the Backspace or Delete keys, or if you performed any other mouse or keyboard action 
after the deletion.



Cut

This command removes the selected text or object from your publication and places it on the Clipboard. 
The text or object can then be pasted elsewhere in the publication or in a different publication. The text or 
object you cut replaces the previous contents of the Clipboard. This command is greyed if no text or 
object is selected.

To cut an item, select the text or object you wish to cut.

Select Edit, Cut (Alt E, C) from the menu.

Keyboard shortcut: Shift+Delete



Copy

Places a duplicate of the selected text or object on the Clipboard; the text or object can then be pasted 
elsewhere in the publication or to a different publication. Copy leaves the original text or object intact, but 
the text or object you copy replaces the previous contents of the Clipboard. This command is greyed if no 
text or object is selected.

To copy text, you must be in Text mode. To copy an object, you must be in Object mode.

To use Copy:

Select the text or object you wish to copy.

Select Copy (Alt E, O) from the Edit menu.

Keyboard Shortcut: Ctrl+Insert



Copy to Master Page

This option copies the selected item, or group of items to the master page associated with the page of the
publication with which you are working (either the left or right master page). The text or object you copy 
then appears on all pages for which that master page is activated. This command does not affect the 
contents of the Clipboard.

To copy an item to the master page:

Select the item you wish to copy.

Select Copy to Master Page from the Edit menu (Alt E, M).



Paste

The Paste command places the contents (text only) of the Clipboard in the publication at the current 
cursor position. The Paste command is greyed if the Clipboard is empty or does not contain text. (See 
Paste Object for information on pasting Objects from the Clipboard.)

To Paste text:

Place the text cursor at the location where you would like the text inserted.

Select Paste from the Edit menu (Alt E, P).

Keyboard shortcut: Shift + Insert



Paste Object

Places the contents of the Clipboard (objects only) in the publication at the current cursor position. The 
Paste command is greyed if the Clipboard is empty or does not contain an object. This command will not 
retain linking information from another application. (See Paste for information on pasting Text from the 
clipboard)

To Paste an object:

Place the cursor at the location where you want the object to be inserted.

Select Past Object from the Edit menu (Alt E, A).



Paste Link

This command activates the OLE frame tool allowing you to place the contents of the Clipboard (OLE 
objects only) into your publication. Using the Paste Link command ensures that the pasted information 
maintains the link to the application from which the object was copied. The Paste Link command is greyed
if the Clipboard does not contain an OLE object. The OLE object remains on the Clipboard until you cut or
copy another block of text or an object.

To Paste an OLE link:

Select Paste Link from the Edit menu (Alt E, L).

Place the cursor at the location where you would like the object inserted.    Click the mouse button and
drag until you have a frame of the desired size.



Select All Text

This command lets you to select all the text in the current story. Use this command to perform an action 
on all the text in the story, such as changing the character or paragraph attributes, applying a style, 
cutting, copying, or checking spelling.

To Select All Text:

Place the text cursor in the frame containing the text you wish to select.

Choose Select All Text from the Edit menu (Alt E, L).

Keyboard shortcut Ctrl + Numpad 5



Searching for Text

This command searches through the entire publication for text you specify. By default, Search will locate 
all occurrences of the specified text that appear below the current cursor position. (See Search 
Backwards below.)

Select this command by choosing Search from the Edit menu (Alt E, S).

Keyboard shortcut F7

Once you select Search, a dialog box will appear with the following:

Search For Enter the text you want to search for in this box. You can enter up to 255 
characters in any combination of upper and lower case letters. (See the Ignore 
Case option, below.)

Search Backwards Check this option to search for occurrences of the specified text before the 
current cursor position.

Ignore Case Accept this default to locate all occurrences of the specified text, regardless of 
whether they appear in upper or lower case. Turn this option off to search for only
those occurrences which match your specified arrangement of upper and 
lowercase characters.

Whole Word Only Option locates the whole words you specify only; it does not stop if the characters
you specified are contained within other words.

Search This Story Only/
Entire Publication The default (This Story Only) will limit your search to the current story in the 

publication. Select Entire Publication to search through all the stories in the 
publication for the specified text.



Replacing Text

The Replace... command searches for occurrences of specified text and substitutes it with the given 
replacement text. By default, Replace will locate and replace all occurrences of the specified text that 
appear below the current cursor position. (See Search Backwards below.)

Select this command by choosing Replace from the Edit menu (Alt E, R)

Keyboard shortcut: F8

Once you select Replace, a dialog box will appear with the following:

Search For Enter the text you want to search for in this text box. You can enter up to 255 
characters in any combination of upper and lower case letters. (See the Ignore 
Case option, below.) 

Replace With Enter the replacement for the text you are searching for in this text box.

Search Backwards Check this option to search for occurrences of the specified text before, or above,
the current cursor position.

Ignore Case Accept this default to replace all occurrences of the specified text, regardless of 
whether they are in upper or lower case. Turn this option off to replace only those
occurrences which match your specified arrangement of upper and lowercase 
characters.

Whole Word Only Option replaces whole words only; it does not stop if the characters you specified
are contained within other words.

Replace All Use this option if you want Publisher to replace all occurrences of the search text 
with the replacement text. Be careful using this option, because you are not 
prompted to change each occurrence individually, and there is no Undo function. 
Click on Start to begin searching. Publisher locates each occurrence of the 
search text, and replaces it with the text you specified.

Replace All In The default (This Story Only) will replace occurrences of the specified text in the 
current story only. Select Entire Publication to replace occurrences of the 
specified text in all the stories in the publication.



Repeat Last Search Or Replace

To repeat the last Search or Replace using the same specified text, choose Edit, Repeat Last (Alt, E, L, 
Enter).

Keyboard shortcut: Shift + F7



Links

The Links command allows you to change the type of OLE link object an object has, and edit the linked 
object. This command is greyed unless a linked object is selected. To choose the links command, select 
Links... from the Edit menu (Alt E, K).

When you choose the Links... command, the Link Properties dialog box appears.

Links Displays information about the source application and file name for the data in 
the linked object.

Update Allows you to switch between automatic and manual updating.

Edit Loads the server application and the file to which the object is linked. The data 
used for the link is highlighted (if applicable). Any changes made to the source 
data are then updated in the OLE object.

Activate If the OLE object has a purpose other than displaying data, for example, if you 
have linked an object that will play a tune, the Activate option carries out the 
desired action.

Update Now Updates the link when Manual Update is the current option.

Cancel Link Removes the link between the OLE object and the server. The object cannot be 
relinked and is treated like any other Publisher object (i.e. a picture or text frame.)

Change Link Activates the Open dialog box from the server application, allowing you to choose
a different file for linking.



Object

To start an OLE server application and edit an OLE object in a publication, select Edit, Object from the 
menu (Alt E, O,O, Enter, E).



View Menu Commands

Facing Pages Displays two pages vertically. Works only if the Facing Pages option on the Page 
Setup dialog box is turned on. 

Actual Size Displays the publication at its actual size when printed.

Keyboard shortcut: Ctrl+1

Fit Page in Window Scales publication to fit an entire page in the display window.

Keyboard shortcut: Ctrl+9

Fit Margins in WindowScales publication to fit the area within the page margins in the display window.

Keyboard shortcut: Ctrl+8

400% Size Displays the publication at four times its printed size.

Keyboard shortcut: Ctrl+4

200% Size Displays the publication at twice its printed size.

Keyboard shortcut: Ctrl+2

75% Size Displays the publication at three quarters its printed size.

Keyboard shortcut: Ctrl+7

50% Size Displays the publication at half its printed size.

Keyboard shortcut: Ctrl+5

25% Size Displays the publication at one quarter its printed size.

Keyboard shortcut: Shift+Ctrl+4

Ruler Turns the horizontal and vertical rulers on or off.

Paragraph Breaks Turns the display of paragraph markers on or off.

Pictures Turns the display of pictures on or off.

Preferences... Allows you to the change the default settings for ruler, guide, and Personal 
Template Catalog options.



Ruler

This command turns the horizontal and vertical rulers on or off. To turn rulers on or off, select View, Ruler 
from the menu (Alt V,R).

When selected, the rulers will appear at the top and left edges of your display and a check mark will 
appear next to the word "Ruler" on the menu.

The rulers uses inches as a default unit of measure. You can change the unit of measure to points, picas 
or centimeters using the Preferences... command. 

When you are in Text mode, the current margin and tab stop settings appear just below the horizontal 
ruler. You can change the margin settings by dragging the margin indicator with the mouse. You can 
delete a tab setting by pointing to the tab indicator with the mouse cursor, and clicking and dragging the 
tab marker off the ruler. You can add a new tab setting by pointing to the new position and clicking the left 
mouse button.



Paragraph Breaks

This command turns the display of paragraph markers on or off. To turn Paragraph Breaks on or off, 
select View, Paragraph Breaks (Alt V,B) from the menu. A check mark will appear next to the words 
"Paragraph Breaks" when this option is turned on.

Paragraph markers are useful for showing hard carriage returns or line breaks. These characters are for 
display only and do not print.



Pictures

This command turns the display of pictures on or off. When Pictures is turned on, pictures are displayed 
in your publication. When Pictures is turned off, a grey rectangle is used to indicate each picture's 
position.

To turn the picture display on or off, select View, Pictures (Alt V,I) from the menu. A check mark will 
appear next to the words "Pictures" when this option is turned on.

Turning Pictures off speeds up screen re-draws, and makes scrolling through the publication faster. When
you print the publication, pictures are printed regardless of whether the Pictures command is on or off.



Preferences...

This command allows you to the change the default settings for ruler, guide, and Personal Template 
Catalog options. These defaults are overridden by your selections for the Ruler or Guides commands. 
You can also change the text cursor width using the Preferences... command.

To set your preferences, select View, Preferences... (Alt V, P) from the menu. When you select this 
command, a dialog box with the following options will be displayed:

Cursor Width This option allows you to change the width of the text cursor for better visibility. To
change the cursor width, type a new value in the Cursor Width text box. This 
value represents how many pixels wide the cursor will be. Place the I-beam 
cursor in the Test box to examine the new cursor width.

Ruler Visible This option turns the display of the rulers on or off.

Snap to Rulers If you check this option, the cursor "snaps" to the nearest intersection of invisible 
lines extending out from the tick marks on the horizontal and vertical rulers. This 
feature helps you precisely position frames and objects, and create guides that 
are perfectly aligned with the ruler tick marks. The rulers do not need to be 
displayed for the Snap to Rulers option to work.

Snap to Guides This option causes the cursor to snap to the vertical or horizontal guides as it 
approaches them. This makes it easier to align frames and objects with the 
guides.

Lock Guides This option locks the guides into position to prevent you from mistakenly moving 
them when you move other items.

Display Guides Use this option to select whether your guides should be displayed in front of 
frames or behind them. Select Off if you do not wish to display the guides.

Units This option allows you to specify whether the rulers use inches, points (and 
picas), centimeters, or decimal inches as the unit of measure.

Template Catalog This option allows you to choose the default template catalog that appears when 
you choose the View Personal Catalog command from the File menu.



Page Menu Commands

Go to Page... Allows you to jump to a different page in your publication.

Insert Page... Inserts a blank page into your publication.

Delete Page Removes the page you specify.

Move Page Allows you to move a page to another location in your publication.

Column Guides... Creates columns with guides to help you position text and picture frames.



Go to Page...

This command allows you to jump to a different page in your publication. To jump to another page in your 
publication, select Page, Go To Page... (Alt P, G) from the menu. Then type the page number you want to 
go to and click on OK to jump to that page.



Insert Page...

To insert a blank page into your publication at the location you specify, pick Page, Insert Page... (Alt P, I) 
from the menu. Then specify where you want to add the blank page by selecting one of the following 
options:

Add Page to End Adds a blank page to the end of your publication.

Before Current Page Adds a blank page before the page on which the cursor is currently positioned.

After Current Page Adds a blank page after the page on which the cursor is currently positioned.

Add As Page # Adds a blank page that becomes the page number you specify.

Insert [_] Pages Specify the number of pages you want to add by typing in a number.



Delete Page

Removes the page you specify, along with all data on that page. To delete a page, select Page, Delete 
Page... (Alt P, D) and type the number of the page you want to delete.

Note: All data will be lost on any pages you delete.



Move Page

This option allows you to move a page to another location in your publication. To move a page pick Page, 
Move Page... (Alt P, M) from the menu, and enter the following:

Move Page Type the number of the page you want to move.

To Page Type the page number that you want the moved page to become.



Column Guides...

The Column Guides... command divides the page area within the left and right page margins into 
columns, and places column guides on the page to help you position text and picture frames. Column 
guides are displayed in purple to distinguish them from normal guides which are displayed in blue.

To add column guides, position the cursor on the page where you want them, click on the page to make it 
active, and choose the Page, Column Guides... command (Alt P, C).You then must specify the number of 
columns you want and the "gutter" or the amount of space between the columns.

Number of columns Specify the number of columns that you want on the page. You can specify 
from 1 to 20 columns.

Gutter between columns Specify the size of the space between columns, or 0 if you don't want space 
between the columns. This specification uses the unit of measure defined 
using the Preferences... command in the View menu. The default is inches.

Guide Selection Select a display option for column guides on this page:

No column guides No column guides are to appear on this page

Column guides Displays column guides only

Column and mid-gutter Displays column guides and additional guide lines down the
guides center of each gutter (useful for placing vertical ruling lines between 

columns)

Column, mid-gutter, Displays column guides, mid-gutter guides, and two
and side guides additional guide lines outside the left and right margins.

You cannot create columns of unequal width using the Column Guides... command. Nor can you move 
column guides with the mouse. You must change them through this dialog box.

You can also add column guides to the Master Page so that they appear on all pages in the publication 
for which the Master Page is active. 



Text Menu Commands

Character... These are commands that allow you to change the character formatting (font, 
size, type style, and position on text line) of text you have selected, or for any 
new text you type.

Keyboard shortcut: Ctrl+T

Paragraph... Commands that allow you to change the formatting (indents, borders, tabs, 
spacing above and below the paragraph, alignment, tabs, and background 
shading) of currently selected paragraphs or any new paragraphs in text you 
type.

Keyboard shortcut: Ctrl+M

Apply Style... Command that allows you to apply one of the existing styles to selected text or to
any new text you type.

Define Styles... This command allows you to create, edit, rename, and delete styles.

Soft Hyphenation This command lets you manually set where Publisher hyphenates a word.

Character Spacing This command allows you to adjust the amount of space between characters.



Character...

This menu option displays a dialog box for changing the character formatting (font, size, type style, and 
position) of the selected text or for any new text you type. To change character formatting, pick Text, 
Character (Alt-T, A) from the menu.

Keyboard shortcut: Ctrl+T

When you choose the Character... command, the Character dialog box appears with the following options:

Font Displays the name of the text font currently in use, or the name of the font to be 
used for any new text entered. A scrolling window below lists all fonts available 
for the selected printer. To change the font, and select a new font from the list or 
type in a font name. If no text is selected in the publication, the font change 
applies to any new text you type. You can also apply character styles from the 
Text mode control strip.

Style Allows you to change the selected text to an italic, bold, or bold italic font. If no 
text is selected, the style is applied to any new text you type. You can also apply 
character styles from the Text mode control strip.

Size The window displays the point size of the selected text, or the selected font for 
new text.To change the point size, select a new point size from the scrolling 
window, or type in the new point size. If you use scalable fonts, you can select 
any point size from 4 to 127 points. You can also change the point size from the 
Text mode control strip.

Effects These options let you underline all text, Word underline (underlining of words 
but not spaces between them), place text in all capital letters, or make text 
white (rather than the default black) so that it shows up on a darker background. 
Check the effect you want to apply. If no text is selected, the effect is applied to 
any new text you type.

Position These options determine the position of characters in relation to the baseline, 
allowing you to create Superscript and Subscript characters. The default option 
positions characters on the baseline. Turning on a Position option turns off the 
previous setting. If no text is selected, the position setting applies to any new text 
you type.

Sample Displays a small sample of text in the selected font, style, and size.



Paragraph...

Allows you to change the format specifications (indents, borders, tabs, spacing above and below the 
paragraph, alignment, tabs, and background shading) of currently selected paragraphs or the paragraphs 
of any new text you type. To change paragraph formatting, select Text, Paragraph (Alt T, P) from the 
menu.

Keyboard shortcut: Ctrl+M

Once you have selected Paragraph from the text menu, a dialog box will display the following options:

Indents This option allows you to indent text from the left or right margin. Enter a value for
the Left or Right indent. A zero indent means that the text is aligned flush with the
margin. This command uses the unit of measure defined in Preferences... under 
the View menu. The default unit is inches.

Border This list box allows you to place a line above, below, to the left, to the right, or 
around (box) a paragraph.

Lines... This command allows you to change the width and style of the border lines. The 
settings in this dialog box do not affect the lines used when you draw objects with
the drawing tools.

Alignment. The alignment options determine how selected text or new text you type aligns 
within the paragraph margins. Left aligned is the default. There are four 
alignment options:

Left Aligns the paragraph with the left margin.

Center Centers each line in the paragraph between the left and 
right margins.

Right Aligns the paragraph with the right margin.

Justified Aligns the paragraph flush with both the left and right 
margins.

Spacing This list box allows you to adjust the amount of space above the first line of a 
paragraph, below the last line of a paragraph, and the space between lines of 
text (leading).

Table of Contents Level Identifies the current paragraph as a table of contents entry, and indicates the 
level at which it should appear. You may assign a table of contents level from 1 to
9 to any paragrah that you want to appear in the table of contents. When you 
generate the table of contents using the Table of Contents command on the 
Utilities menu, you have the option of choosing which levels to actually include.

Hyphenation Provides options for hyphenation of text.

None Turns off automatic hyphenation. (Default)

Adjacent Lines Turns on automatic hyphenation.

2 Line Separation/ Turns on automatic hyphenation and ensures
3 Line Separation that at least 2 or 3 non-hyphenated lines appear 

between hyphenated lines.



Tabs... Allows you to add, change, or delete tab stops for the selected paragraph or for 
new paragraphs.

Shades... This option allows you add background shading to a paragraph or fill the 
background with a pattern. Click the Shades button, and select one of the 
Shades or Fills options on the dialog box that appears.

Drop Cap... This option allows you to specify a different point size, font, attribute or style for 
the first character of the paragraph.



Paragraph Borders

You can select from the following border position options:

None No border

Box Border around the entire paragraph

Above Border above the paragraph

Below Border below the paragraph

Above & Below Borders above and below the paragraph

Left Border to the left of the paragraph

Right Border to the right of the paragraph

Left & Right Borders to the left and right of the paragraph

The default choice is None, or no border. The border type you choose is applied 
to the paragraph in which the cursor is located, or to multiple paragraphs if more 
than one paragraph is selected.

Separation This command allows you to adjust the amount of space between the text and its 
borders. The default is .1 inch. This command uses the unit of measure defined 
under Preferences... in the View menu. The default unit is inches.



Line Spacing

Enter values in the following spacing text boxes:

Above Adds space between the top frame boundary and the first line of a paragraph. 
The unit of measurement is in points. You can select from 0 to 127 points (There 
are 72 points to an inch). The default is 0.

Below Adds space below the last line of a paragraph. The unit of measurement is in 
points. You can select from 0 to 127. The default is 0.

Leading Determines the amount of space between lines of text from the baseline of one 
line of text to the baseline of the next. It is expressed as a percentage of the text 
point size. The normal (default) leading is 120% and is based on the largest point
size in the line.



Tabs Menu

Select This text box lists the number, position relative to the left margin, and alignment 
of all current tab settings. Publisher sets a left aligned tab every half-inch from 0 
to 8 inches by default.

Change

Align This list box shows the alignment of the tab setting currently selected
in the Select list box, and allows you to change the alignment of that 
tab or select the alignment for a new tab setting. There are four tab 
alignment options -- left, right, center, and decimal. Left is the default.

Position This text box shows the position of the tab setting currently selected 
in the Select list box, and allows you to remove or replace that tab 
setting, or enter a position for a new tab setting.

Add To add a new tab setting, first delete the setting that appears in the Position text 
box. Then, enter the new setting, change the alignment option if necessary, and 
click on Add.

Delete To delete a tab setting, select the setting you want to delete in the Select list box 
and click on Delete. When you delete a tab, text that was aligned with that tab 
becomes aligned to the next tab to the right of the deleted tab.

Replace To change the alignment or position of an existing tab setting, select the tab in 
the Select list box, change the alignment option or enter a different position 
setting and click on Replace.



Drop Cap

If the cursor is positioned within a paragraph when you select the Drop Cap... option, the first character in 
that paragraph becomes a drop cap. If more than one paragraph is selected, the first character of each 
paragraph in the selected text becomes a drop cap.

To produce drop caps, choose the Drop Cap option. To specify the font, attributes, or size of the drop cap 
character, click on the Drop Cap... button.

Font Select a font for the drop cap character.

Attributes Check Bold, Italic, or both if you wish to add these attributes to the character.

Drop Cap Height Specify a size for the character. This specification is measured in normal lines of 
text. That is, if you specify 2 for Drop Cap Height, the drop cap character will 
equal the height of two lines of text in the normal size.



Apply Style...

This command displays a dialog box containing all styles associated with the document, and allows you to
apply one of the existing styles to selected text or to any new text you type.

To change the style of one or more paragraphs, select the paragraph(s) you want to change and choose 
Text, Apply Style... (Alt T, S). A new dialog box will appear.

The list box at the top of this dialog box displays the name of the style applied to the currently selected 
text. If the selected text contains more than one style, this box is blank. The list below the current style 
displays all the styles that are defined for the publication. When you select a style from this list, it 
becomes the current style and is applied to selected text or to new text.

The Define... button opens the Define Styles dialog box. This is the same as choosing Define Styles... 
from the Text menu.

Note: Publisher applies styles to entire paragraphs only. If you select part of a paragraph and apply a 
style, the style is applied to the entire paragraph.



Define Styles...

This command allows you to create, edit, rename, and delete paragraph styles. The styles you define are 
saved with the publication. To define or change a style, choose Define Styles... command from the Text 
menu (Alt T, D). The Define Style dialog box appears.

The box at the top of the Define Style dialog box displays the name of the style to be edited. The list box 
lists all styles defined in the current publication. When you select a style from this list, it appears in the 
Current box, indicating that it is the style you want to edit.

Add This command allows you to define a new style. When you click on the Add 
button, Publisher deletes the current style name. Type a new style name. A style 
name can be 13 characters long and can contain any character, including 
numbers, spaces, and punctuation marks. Click on the Character... or 
Paragraph... button to provide character or paragraph formatting specifications 
for the new style.

Character... Displays a dialog box for changing the character specifications (font, size, 
attributes, and position) of the current style.

Paragraph... Displays a dialog box for changing the paragraph formatting specifications 
(indents, alignment, drop caps, paragraph and line spacing, hyphenation, tabs, 
and shading) of the current style.

Delete Deletes the current style and removes it from the list of available styles. Any text 
that had the deleted style is automatically assigned the Body Text style.

Rename... This option allows you to rename an existing style. When you click on the 
Rename button, a dialog box appears listing the current name of the style. Type a
new name and click on OK to rename the style.

Add to Normal This option adds the current style to the Normal template.

OK Accepts all the changes you made and closes the dialog box.

Cancel/Close Closes the dialog box without saving the changes. Deleted or renamed styles, or 
changes to character and paragraph specifications can not be canceled. When 
you perform these operations, the Cancel button changes to Close, indicating 
that the changes have been made.



Character Spacing

This command allows you to adjust the amount of space between characters. You can add or subtract 
space between all the characters in a selection of text, or between a single pair of characters. To use the 
Character Spacing command, highlight a group of characters or words, and select Text, Character 
Spacing (Alt T, C) from the menu.

To increase the spacing between a selected set of characters, enter a positive value or click on the up 
arrow. To decrease the amount of space, enter a negative value or click on the down arrow. The Spacing 
value is a percentage of the point size. For example, if the point size is 20 point and you specify -10% in 
the Spacing box, the amount of space between characters is decreased by 2 points.

Select Try to see how the new character spacing will look; the spacing change is made temporarily in the 
publication. (You may need to move the dialog box aside to see the same.) To restore normal character 
spacing, set the Spacing value to 0%.

Note: if you adjust the spacing between a pair of characters, the adjustment applies to the selected pair 
only. It does not apply to other occurrences of the same pair of characters.



Object Menu Commands

Object Information This command allows you to change an object's size and location on the page.

Wrap... This command allows you to specify how text wraps, around frames, as well as 
the amount of space between the frame and the text.

Lines... This command allows you to set the line width and line style for objects you draw 
or have already drawn in Publisher, such as lines, shapes, and borders for 
frames and paragraphs.

Shades... This command allows you to fill rectangles, ovals, round-corner rectangles, and 
text frames drawn using Publisher with shading or a graphic pattern.

Group Objects / This command allows you to group existing objects to
Ungroup Objects select and move them collectively while maintaining their original

positions in relation to one another.

Rotate Object This command rotates the selected object clockwise in multiples of 90 degrees. 
This command works only with pictures.

Horizontal Flip This command flips the selected object horizontally, creating a mirror image. This 
command works only with pictures.

Vertical Flip This command flips the selected object vertically, creating a mirror image. This 
command works only with pictures.

Bring to Front / These commands change the stacking order of overlapping objects on a Send to 
Back page.

Link Text Frames Command link two or more text frames together to allow text to flow sequentially 
from one frame to the next.

Create New Frame Allows you to create one of the four types of Publisher frames.



Object Information

This command allows you to change an object's size and location on the page. When you choose the 
Object Information... (Alt O,O) from the menu, the Object Information dialog box appears.

Keyboard shortcut: Ctrl+G

Picture File Name If the selected object is a picture, Publisher gives you the path and file name.

Position This option allows you to change the position of an object on the page. When you
select the Object Information... command, the object's current distance from the 
left and from the top of the page is shown. To change the position, enter a new 
value for either or both of these settings.

Size This option allows you to increase or decrease the size of a selected object.    
The Width and Height boxes display the current size of the object.    You can 
increase or decrease the size by changing the Width and Height values.

Margins This option allows you to set the distance between the boundary of a text frame 
and the text within the frame. If the selected object is a picture or empty frame, 
the Margins option is greyed. To set margins, enter new values for the left, top, 
right, and bottom settings.

Lock Size and Position This option maintains the size and position of the selected object. This option is 
useful if you are changing the size or position of nearby objects.

Crop From This option allows you to crop, the parts you don't need, from the edges of a 
picture. To crop a selected picture, specify how much you wish to crop from the 
left, top, right, or bottom of the picture. You can crop one or more sides of the 
picture in any combination. Choose No Crop (the default) if you do not wish to 
crop the picture or to restore the full picture You can also crop objects using the 
Crop tool in the Object Mode control strip.

Scale This option allows you to increase or decrease the size of a selected object. This 
option is only available for pictures. The Width and Height boxes show the 
current percentage of the original graphic's size. You can increase or decrease 
the size by specifying a percentage of the original width and height. A larger 
percentage number increases the dimension; a smaller percentage number 
decreases the dimension.

Preserve Aspect Ratio When you change the size of an object, you will usually want to preserve the 
original ratio of width to height. To preserve it, check Preserve Aspect Ratio, and 
specify only a height percentage value. Publisher will set the width in the correct 
ratio.

Note: The settings on this dialog box use the unit of measure set under Preferences in the View menu. 
The default is inches. When you choose this command, the settings on the dialog box apply to the 
selected object.



Wrap...

This command allows you to specify how text flows, or wraps, around frames, as well as the amount of 
space between the frame and the text. This command is also available on the Object Mode Control Strip.

Publisher initially creates a rectangular boundary for each frame in your publication and wraps text with 
respect to that boundary. From the rectangular boundary you can define up to four additional sides (a total
of eight sides) giving you greater control of the wrap characteristics of the frame.

To use the Text Wrap command, select Object, Wrap... (Alt O, W) from the menu. A dialog box will then be
displayed with the following options:

Flow These options determine how text flows around objects:

Select this option to turn the text wrapping function off, and force the text to flow over the
object.

Select this option to stop the text just above the object and continue it just below the
object.

Select this option to wrap text completely around the object.

Gutter Allows you to set the amount of white space that separates the object from the 
text that wraps around it (the "gutter") between the text and the top, bottom, left, 
and right edges of the object's boundaries.



Lines...

This command allows you to set the line width and line style for objects you draw or have already drawn 
in Publisher, such as lines, shapes, and borders for frames and paragraphs. If no object is selected when 
you choose the Lines... command, the changes you make in this dialog box apply to any new objects you 
draw.

To change an object's line width or style, first select the object, and then select the Lines... command from
the Object menu (Alt O, N).

Width There are eight options for line width. You can draw lines ranging from Hairline 
(approximately ¼ point) to 12 points. You can also remove the lines from an 
object (for example, to create a shaded object with no border) by selecting None. 
There are also three options for compound (double) lines. You cannot change the
line widths of compound lines.

Pattern To create broken lines, select one of the four pattern options. You cannot change 
the width of patterned lines. The default is a solid line.

Arrowhead To place arrowheads at the line ends, select one of the arrowhead options. Select
a Start arrowhead to place the selected arrowhead at the point where you begin 
to draw the line. Select an End arrowhead to place the arrowhead at the point 
where you complete drawing the line. Arrowheads can be placed on solid, 
compound, and patterned lines.

Note: The arrowhead options are not available for paragraph borders.



Shades...

This command allows you to fill rectangles, ovals, round-corner rectangles, and text frames 
drawn using Publisher with shading or a graphic pattern. The shades are similar to screens used 
by printers. To fill an object or change its shading or pattern, select the object, and choose the 
Shades... command from the Object menu (Alt O,.S). A Shades dialog box will appear.

The left hand side of the dialog box offers 8 shading options, ranging from opaque white to solid 
black. (The percentages refers to the proportion of black; solid black is 100%). The right side, 
labeled "Fills"    offers 28 fill pattern options. You can fill an item with either a shade or a pattern, 
but not both.

If you apply shades or patterns to text frames, the text in the frame is always displayed on top 
(the shade does not block out the text in the frame). If you choose a dark shade, you may not be 
able to see black text on top of it.



Group / Ungroup Objects

This command allows you to group existing objects so that you can select and move them collectively 
while maintaining their original positions in relation to one another. You can move a group around a page, 
to a different page, or between a normal page and a master page.

There are two ways to group objects:

1. While holding down the Shift key, click the mouse cursor on all the objects that you want to be in the
group. Then, choose the Group Objects command from the Objects menu. (Alt O, G) If only one 
object is selected, the Group Objects command is greyed.

2. Click the mouse cursor outside the top, leftmost object and drag a rectangle around all of the 
objects you want in the group. The bounding rectangle appears as a grey dotted lined box. All 
objects that are completely within the boundary of the rectangle are included in the group. (You 
need not use the Group Objects command.)

If you do not permanently group the objects together by choosing the Group command, the selected
objects will be temporarily grouped until another action is performed.

To Ungroup the objects in a group, select the group and choose Ungroup Objects. If a group is not 
selected, the Ungroup Objects command is greyed.



Link Text Frames

Use this to link two or more text frames together to allow text to flow sequentially from one frame 
to the next. 

Frames may also be linked using the Linking Tool from the control strip.



Create New Frame

This command allows you to create one of four types of frames. You can also create frames using the 
buttons on the Object Mode control strip

Empty Frame Used as a place holder. Can be changed to another type of frame later. 

Text Frame For import or entry of text.

Picture Frame For placement of pictures in your publication.

OLE Frame For placement of a linked or embedded object from another Windows program.

To create a new frame, select Create New Frame from the Object menu and choose the type of frame you
want to create. You can also create new frames using the new frame tools on the control strip.



Master Menu Commands

Master Page This command displays and allows you to edit items on the Master Page. Items 
placed on the Master Page will appear on all associated (left or right) pages of 
the document unless you expressly exclude an item with the Use Master Objects 
for Page # selection.

In Master Page view, you can edit the text or objects on the master page. Normal
page items appear on the master page but they cannot be edited so that you can 
position master page objects in respect to normal page objects. If you have two 
master pages (left and right), this command displays the one associated with the 
page where the cursor is currently positioned.

Use Master Objects Use this command to specify whether items on the Master Page appear
for Page # on the current page. (The "#" in the command is replaced by the current

page number.) When a checkmark appears next to this command, items
on the Master Page appear on the indicated page by default. If you turn
this command off, Master Page items do not appear on the current page.

If you want to use some, but not all, of the Master Page items on a particular 
page, you can group those objects and then copy them to a normal page. If you 
do this, turn off the Use Master Objects for Page # command.



Insert Menu Commands

Page Number This command inserts an automatic page numbering character (#) at the current 
cursor position. When you print your document, Publisher prints the correct page 
number on each page that contains the page number character. To put page 
numbers on all or most pages in your document, place the page numbering 
character on the master page(s).

Keyboard shortcut: Shift+Ctrl+3

Date This command inserts the current system date at the cursor position. To put the 
date on all or most pages in your document, place the date on the master 
page(s).

Keyboard shortcut: Shift+Ctrl+D

Time This command inserts the current system time at the cursor position. To put the 
time on all or most pages in your document, place the time on the master 
page(s).

Keyboard shortcut: Shift+Ctrl+T



Utilities Menu Commands

Table of Contents... This command automatically generates a table of contents based on the Table of 
Contents levels specified in the Paragraph dialog box. The table of contents is 
created at the current cursor position.

Mark Index Entry... This command allows you to identify each word or phrase in your publication, 
along with its page number, for which an index entry is to correspond.

Keyboard shortcut: Shift+Ctrl+M

Edit Index... This command allows you to edit, locate, or remove index entries.

Generate Index... This command automatically generates an index from the marked index entries.

Spell Check... This command allows you to check the spelling of words in your publication.

Keyboard shortcut: F9

Thesaurus... This command provides a list of synonyms for the word at the current cursor 
position, and allows you to replace the word with one of the synonyms.

Keyboard shortcut: Shift+F9

Picture Catalog... Use this command to create and maintain one or more catalogs of pictures you 
use frequently.



Table of Contents...

This command automatically generates a table of contents based on the Table of Contents levels 
specified in the Paragraph dialog box. To generate a Table of Contents, select Utilities, Table of 
Contents... (Alt U, C) from the menu. Enter the following:

Paragraph Levels Specify which of the Table of Contents Levels you defined in the Paragraph 
dialog box you want to include in the table of contents. You can define up to nine 
levels, but you need not include all of them in the table of contents.

Specify the First and Last level you want to include, or accept All (the default) to 
include all the defined levels.

The table of contents will be created at the current cursor position.



Mark Index Entry...

The Mark Index Entry..., Edit Index..., and Generate Index... commands are all used to create an index for
the publication.

The Mark Index Entry... command allows you to identify each word or phrase in your publication, along 
with its page number, for which an index entry is to correspond. To mark an index entry, select the text in 
the publication and then choose the Mark Index Entry... command from the Utilities menu (Alt U, M). You 
can select a single word or a phrase as an index entry.

Keyboard shortcut: Shift+Ctrl+M

The entry you have highlighted appears in the Index Entry list box. If no selection is marked, the word 
nearest the cursor appears in the Index Entry list box.

If you want the page reference of the marked entry to appear in the index under a word or phrase you 
have not yet defined, replace the entry in the Index Entry list box by pressing the Backspace key and 
typing in the new entry.

If you want the page reference of the marked entry to appear in the index under a previously defined 
entry, click the down arrow next to the Index Entry box. An alphabetical scroll list of all currently defined 
index entries appears. Scroll through the list to select the entry under which the marked entry and page 
reference are to appear.



Edit Index...

This command allows you to edit, locate, or remove index entries. When you select the Edit Index... 
command from the Utilites menu (Alt U, E), the Edit Entry dialog box appears.

Click the arrow next to the Index Entry list box to display a list of currently defined index entries, and 
select an entry from the list. Edit or delete and retype the entry, or select one of the options at the bottom 
of the dialog box.

Go To Choose Go To to move the cursor to the place in the publication where the index 
entry listed in the Index Entry list box first appears.

Remove Choose Remove to delete the selected entry from the Index Entry list.

The Mark Index Entry..., Edit Index..., and Generate Index... commands are all used to create an index for
the publication.



Generate Index...

This command automatically generates an index from the marked index entries. When you choose the 
Generate Index... command from the Utilities menu (Alt U, G), the Index dialog box appears.

The Index dialog box lets you choose how the listings under each letter of the alphabet are separated.

None Creates an index with no separations between the listings under each letter.

Blank Line Separates the listings under each letter with a blank line.

Letter Separates the listings under each letter by placing the individual letter before the 
listings.

The index will appear at the current cursor position.

The Mark Index Entry..., Edit Index..., and Generate Index... commands are all used to create an index for
the publication.



Spell Check...

This command allows you to check the spelling of words in your publication. To run the Spell Checker, 
select Utilities, Spell Check... (Alt U, S) from the menu.

Keyboard shortcut: F9

Select one of the following options:

Check Entire Publication Checks the spelling of every word in the publication.

Check Selection Checks the spelling of selected text only. If no text is selected, this option
is greyed.

After selecting one of these options, click on the Begin button to start the Spell Check. When Publisher 
finds a word that it cannot find in its dictionaries, the Spell Check dialog box appears.



Spell Check Dialog Box

Word This box displays the word that Publisher cannot find in its dictionaries.

Change To If the Always Suggest option is turned off, this text box is blank, allowing you to 
type in the correct spelling. If the Always Suggest option is on, this text box 
displays one of the possible replacements for the misspelled word listed in the 
Suggested Words list box.

To edit the suggested word, place the cursor to the right of the word, press 
Backspace to delete all or part of the word, and type in the correct spelling. To 
select a different replacement option, scroll through the Suggested Words scroll 
list. Click on Accept to replace the misspelled word in the publication with the 
revised spelling in the Change To text box.

Suggested Words This list box displays a list of possible replacements for the misspelled word. If 
the Always Suggest option is turned on, the list appears whenever Publisher 
detects a misspelled word. If the Always Suggest option is off, the list appears 
when you click on the Suggest button.

The selected word in the list also appears in the Change To text box. Scroll 
through the list to select a different replacement option.

Always Suggest If this option is turned on, Publisher automatically provides a list of possible 
replacement words when it detects a misspelled word.

Change The Change button replaces the misspelled word in the publication with the word 
that appears in the Change To text box, and continues with the Spell Check.

Add Word The Add Word button adds the word in question to your user dictionary, so that 
the Spell Check will not question the word every time you check spelling. This 
feature is useful for frequently used words such as proper names and technical 
terminology. Publisher creates a user dictionary in a file named USR.DCT, and 
adds entries every time you select Add Word. You can edit the user dictionary by 
opening this file. Be sure to save the file under the same name so that Publisher 
can find it later. (You cannot edit the normal dictionary that Publisher uses to 
check spelling.)

Skip The Skip button leaves the misspelled word as it is in the publication, and causes
the Spell Checker to ignore future occurrences of this word as it is currently 
spelled.

Suggest If the Always Suggest option is turned off, click on the Suggest button to display a
list of suggested replacements for the misspelled word.

Stop The Stop button ends the Spell Check process immediately and returns you to 
the publication.



Thesaurus...

The Thesaurus... command provides a list of synonyms for the word at the current cursor position, and 
allows you to replace the word with one of the synonyms. To use the Thesaurus, select Utilities, 
Thesaurus (Alt U, T) from the menu.

Keyboard shortcut: Shift+F9

The selected word appears in a search box at the top of the dialog box. Synonyms for the selected word 
appear in a list box below the selected word. Select one of the synonyms (the first synonym is the default 
selection) and choose one of the following options:

Replace The Replace button replaces the original word with the selected synonym and 
returns you to the publication.

Cancel Choose the Cancel button if you do not want to replace the original word in your 
publication with a synonym. The Cancel button returns the publication to the 
screen unchanged.

Lookup The Lookup button tells Publisher to look up synonyms for the selected word in 
the Synonyms list box. When you choose Lookup, the selected synonym moves 
to the Word text box, and the Synonyms list box displays the new list of 
synonyms. You can look up words in the Synonyms list box as many times as 
you wish.

Original This button returns the word you originally marked to the Word text box, and 
returns its synonyms in the Synonyms list box.



Picture Catalog...

This command creates and maintains one or more catalogs of pictures you use frequently. Picture 
catalogs can consist of PCX, BMP, TIF, WMF, CLP, TGA, WPG, or GIF images. To use the Picture 
Catalog, Select Picture Catalog... from the Utilities menu (Alt U, P).

You can also access Picture Catalog functions from the Picture dialog box that appears when you create 
a picture frame.

Once you have selected the Picture Catalog... option a dialog box will be displayed. From this dialog box, 
you can view or add images to an existing picture catalog or create a new catalog.

Source To create a picture catalog, the source must be file. The Clipboard option is 
greyed.

Catalog To view or add pictures to an existing catalog, select the catalog from the drop-
down list box. You can also type *.cat or select Catalog for the File Type, select 
the drive and directory from the Directories list box, and select the catalog name 
from the Files list. Once you select a catalog you can either view the catalog or 
add pictures to it.

File Name In this text box you can enter the name of a new catalog or select a picture file to 
preview or add to the current catalog. If the current File Type is Catalog (.cat) 
enter a new or existing catalog name into this text box, and select the View 
Catalog... or Create Catalog button.

If you select any other file type, enter the name of the picture file you want to 
select, and select the Preview Picture option or Add to Catalog button. You can 
also change the drive and directory from the Directories list box and then select 
the file from the Files list box.

File Type Select the file type of the picture file you want to preview or add to the catalog, or 
select Catalog (.cat) to view or create a catalog.

Files / Directories Select the drive and directory of the picture file or catalog from the Directories list 
box, and select the file from the Files list box.

View Catalog This command displays small representations of the pictures in the current 
catalog, and allows you to remove pictures from the catalog. Type the name of 
the catalog you wish to view in the File Name list box and select View Catalog. 
The Picture Catalog dialog box appears.

Add to Catalog Use this button to add a picture to an existing catalog. To add a picture, select the
catalog name from the Catalog drop-down list box. Type the name of the picture 
file in the File Name text box or select the directory and file from the Directories 
and Files lists. Select Add to Catalog.

Create Catalog To create a new catalog, choose the file type Catalog (.cat) from the File Type 
drop-down list box, type a name for the catalog in the File Name text box, and 
select Create Catalog.

Preview Picture Check this option to display a small representation of the picture file listed in the 
File Name box.



View Picture Catalog

This dialog box displays the pictures in the catalog, along with the file name of the currently 
selected picture. If the catalog contains more pictures than can be displayed at once, choose a 
picture from the Files list box, or use the scroll bar at the bottom of the screen. To remove a 
picture from the catalog, select the picture and select Remove.



Window Menu Commands

Tile This command arranges all open windows in non-overlapping "tiles" so that all 
windows are visible.

Cascade This command arranges all open windows in an overlapping fashion such that 
the title bar of each window remains visible and the active window is on the top.

Arrange Icons If you have minimized publications and the publication window is not maximized, 
this command arranges the icons for the minimized publications in a row at the 
bottom of the PFS:Publisher window, starting from the lower left corner.

Save Setup This command allows you to set defaults related to how PFS:Publisher appears 
when you open the application.

QuickButton Palette This option lets you access commonly used Publisher commands via a small, 
movable menu of icons that appears on your screen.

Keyboard shortcut: Shift + Ctrl + Q

Publication1, etc. These commands determine the stacking order of your open publications. The 
Windows menu shows one of these commands for each open publication. If any 
of the open publications have been previously saved, their filenames appear 
instead of "Publication<number>," etc. in the menu.

The publication you select from this list is the active publication, and
appears "on top" of the stack. The selected publication is marked with a
checkmark.



Save Setup

This command allows you to set defaults related to how PFS:Publisher appears when you open the 
application.

Save Desktop This option saves the publication windows as you've arranged and sized them so
that they appear in the same position and size the next time you run Publisher. 

Maximize Publisher If you check this option, the Publisher window is maximized and fills the
on Startup entire screen when you start it. If you do not check this option, Publisher

opens "cascaded" in front of any other open windows on the desktop.



QuickButton Palette

The QuickButton Palette gives you quick access to most of the commonly used Publisher commands 
through a small, moveable window that displays on your publication screen. To display the QuickButton 
Palette, choose the QuickButton Pallete item from the Window (Alt W, Q) menu.

Keyboard shortcut: Shift+Ctrl+Q

You can select the Publisher command icons you want to be displayed in your menu. Four icons (Cut, 
Copy, Paste and Print) appear in the palette by default. By using the Configure menu on the palette, you 
can display up to 24 commands. These are the configuration options for the QuickButton Palette:

Hide Removes the QuickButton Palette from the screen.

Configure Allows you to add and remove commands from the palette.

Size Allows you to resize the palette without a mouse.

Move Allows you to move the palette around the screen without a mouse.

Keep Locks the palette to the top or bottom and right or left of your screen.



Help Menu Commands

Index This command allows you to select a topic from an alphabetical listing of all 
topics for which help is available. When you choose the Index command, the 
Index dialog box appears. To get help with any topic in the list, select it by either 
double-clicking it with your mouse or highlighting it with the keyboard and 
pressing Enter.

Commands This command allows you to get help with menu commands. When you choose 
Commands, the Commands dialog box appears. This dialog box lists all the 
Publisher menus. When you select a menu from the list, Publisher displays 
information on each command in the menu.

Concepts This command allows you to select from a list of "concepts" or Publisher 
functions for which help is available. When you choose Concepts, the Concepts 
dialog box appears. Select a concept from the list by either double-clicking it with 
your mouse or highlighting it with the keyboard and pressing Enter.

Keyboard This command displays a list of all short-cut key combinations for menu 
commands and control strip items.

Using Help This command displays the Microsoft Windows explanation for using the 
Windows Help system.

About This command displays information about the version of PFS:Publisher you are 
using.



 Keyboard Short cuts
Keyboard short cuts help speed the layout and formatting of a publication. This appendix includes a 
comprehensive summary of all the keyboard short-cuts available in PFS:Publisher.
Working With Text

Working With Objects

Working With Publications

Working With Windows



Keyboard Short cuts for Working With Text

Paragraph Controls
Left Align Ctrl + L 

Centered Ctrl + C 

Right Align Ctrl + R 

Justify Ctrl + J

Styles Ctrl + E 

Paragraph Formatting Ctrl + M

Moving The Text Insertion Point
Previous Character Left Arrow 

Next Character Right Arrow 

Previous Word Ctrl + Left Arrow 

Next Word Ctrl + Right Arrow 

Previous Line Up Arrow 

Next Line Down Arrow 

Previous Paragraph Ctrl + Up Arrow 

Next Paragraph Ctrl + Down Arrow

Beginning of Line Home 

End of Line End 

Beginning of Document Ctrl + Home

End of Document Ctrl + End

Top of Frame Ctrl + PgUp 

Bottom of Frame Ctrl + PgDown

Selecting Text
Previous Line Shift + Up Arrow 

Next Line Shift + Down Arrow

Beginning of Line Shift + Home 

End of Line Shift + End 

Beginning of Story Ctrl + Shift + Home 

End of Story Ctrl + Shift + End

Previous Window Shift + PgUp 

Next Window Shift + PgDn 

Top of Window Ctrl + Shift + PgUp 

Bottom of Window Ctrl + Shift + PgDn

Previous Character Shift + Left Arrow 



Next Character Shift + Right    Arrow 

Previous Word Ctrl + Shift + Left Arrow 

Next Word Ctrl + Shift + Right Arrow 

Previous Paragraph Ctrl + Shift + Up Arrow 

Next Paragraph Ctrl + Shift + Down Arrow

Entire Story Ctrl + Numpad "5"

Deleting / Changing Text
Next Character/Selection Del 

Prev. Character/Selection Backspace 

Next Word Ctrl + Del

Previous Word Ctrl + Backspace

Search F7 

Replace F8 

Repeat Last Shift + F7 

Insert/Overstrike Modes Ins

Changing Appearance of Text
Font Ctrl + F 

Font Size Ctrl + H

All Caps Ctrl + K 

Bold Ctrl + B 

Italic Ctrl + I 

Underline Ctrl + U 

Word Underline Ctrl + W

Subscript Ctrl + = 

Superscript Ctrl + Shift + =

Character Formatting Ctrl + T

Normal F5 

Reset Ctrl + Space 

Remove Par. Overrides Ctrl + X

Adding Special Characters
Hard Line Break Enter 

Non-Breaking Space Ctrl + Shift + Space 

Non-Breaking Hyphen Ctrl + Shift + - 

Bullet Ctrl + Shift + 8





Keyboard Short cuts for Working With Objects

Working with Objects
Master Objects for Page # Ctrl + Shift + P

To Change Position Ctrl + G

To Change Size Ctrl + G 



Keyboard Short cuts for Working With Publications

Publication Management
New Ctrl + N

Open Ctrl + F12 or Ctrl + O 

Save Ctrl + S

Save As F12

Print Ctrl + Shift + F12 or Ctrl + P

Moving Around the Publication
Go to Previous Page PgUp 

Go to Next Page PgDown

Go to Page # F6 

Viewing the Publication
Actual Size Ctrl + 1 

400 percent Ctrl + 4 

200 percent Ctrl + 2 

75 percent Ctrl + 7 

50 percent Ctrl + 5

Fit Margins in Window Ctrl + 8 

Fit Page in Window Ctrl + 9

Editing Functions Press
Undelete/Undo Alt + Backspace

Copy Ctrl + Ins 

Cut Shift + Del 

Paste Shift + Ins 

Utilities Press
Thesaurus Shift + F9

Spell Check F9 

Mark Index Entry Ctrl + Shift + M 

View Personal Catalog Ctrl + Shift + V

Insert Press
Page Number Ctrl + Shift + 3 



System Date Ctrl + Shift + D 

System Time Ctrl + Shift + T



Keyboard Short cuts for Working With Windows

Application Controls
Help for the Active Dialog Box F1

The Menu Bar F10 or Alt

The QuickButton Palette Ctrl + Shift + Q

Windows Controls
Function Document Window Application Window

Close Ctrl + F4 Alt + F4 

Restore Ctrl + F5

Next Ctrl + F6

Move Ctrl + F7 Alt + F7 

Size Ctrl + F8 Alt + F8 

Minimize Ctrl + F9 Alt +F9 

Maximize Ctrl + F10 Alt + F10



 PFS:Publisher Concepts
The Control Strip

Publication Basics

Working With Text

Working With Objects



The Control Strip

The Control Strip provides quick access to many of the functions available in the menus. The tool buttons 
available on the Control Strip change depending on the Publisher mode you are working in. Publisher has
two modes: Object Mode and Text Mode.

The Control Strip in Object Mode has tools for creating frames, drawing graphics and cropping pictures. 
The Control Strip in Text Mode has tools for choosing a typeface and style, selecting font size, and 
formatting paragraphs. Publisher always starts in Object Mode.

These buttons are used to switch between Object and Text modes:

Text Tool    Click on this tool to work in Text Mode.

Object Tool    Click on this tool to work in Object Mode.



Text Mode Control Strip

The Text Mode Control Strip provides you with quick access to the tools used to change the size, 
typeface, paragraph alignment and style of the text in your publication. To use the Text Mode Control 
Strip, you must have the Text Tool selected on the control strip (see 1). Below is a listing of each button 
on the Text Mode Control Strip. From left to right:

1.    Text Tool / Object Tool Text Tool must be selected.

2.    Text Selection Box Selects a typeface to use on selected text.

3.    Point Size Selection Selects a point size to use on selected text.

4.    Font Style Buttons Sets bold, italic and bold italic styles.

5.    Paragraph Alignment Buttons Sets paragraph alignment.

6.    Paragraph Style Selection Box Set paragraph style to use for selected text.



Object Mode Control Strip

The Object Mode Control Strip provides the tools to create text and graphics frames, manipulate pictures, 
and draw graphic elements such as boxes and lines. To use the Object Mode Control Strip, you must 
have the Object Tool selected on the control strip (see 1). Below is a listing of each button on the Object 
Mode Control Strip. From left to right:

1)    Text Tool / Object Tool Object Tool must be selected.

2)    Drawing Tools

Rectangle drawing tool Draws rectangles and squares.

Rounded rectangle drawing tool Draws rectangles and squares with rounded 

corners.

Oval drawing tool Draws ovals and circles.

Constrained line tool Draws horizontal and vertical lines.

Unconstrained line tool Draws freehand lines.

3)    Frame Tools

Empty frame tool Creates empty placeholder frames.

Text frame tool Creates Empty Text Frame.

Picture frame tool Creates Picture Frame and allows you to import 

a picture.

OLE object frame tool Creates OLE Frame and adds OLE object.

4)    Picture Tools
Cropping Tool Crops unneeded portion of pictures.

Wrap Border Tool Allows you to specify a non-rectangular text
wrap border around pictures.

Link Frames Tool Links text frames for continuous text flow.



Wrap Border Tool
This tool allows you to create a non-rectangular text wrap around a picture.
To use the wrap border tool, select object you want to wrap text around and select the wrap border tool 
from the control strip. The handles around the object will change from solid to dotted. Use your mouse to 
drag the dotted handles to their new location.
You can move each of the eight frame handles as many times as you wish to create an irregularly shaped
wrap border. Text will flow around this border as closely as it is allowed based on the gutter settings 
specified in the Wrap... dialog box under the Object menu.



Drawing Tools

Publisher provides a variety of tools for drawing boxes, circles, lines, and other objects in your publication.
To use a drawing tool, click on the appropriate button on the Object Mode control strip. Move the pointer 
arrow to the location where you want to draw the object, hold down the left mouse button and drag to 
create an object of the desired size.

The Drawing Tool buttons:

Rectangle drawing tool.
Select this button to draw rectangles or squares.

Rounded rectangle drawing tool.
Use this tool to draw rectangles or squares with rounded corners.

Oval drawing tool.
Click on this button to draw oval or circular objects.

Constrained line tool.
This tool draws straight horizontal and vertical lines.

Unconstrained line tool.
This tool allows you to draw freehand lines at any angle.

To change the thickness or appearance of an object you have drawn with the drawing tools, use the 
Lines... command under the Object menu.



Paragraph Alignment Tools

The Paragraph Alignment buttons on the Text Mode control strip offer a quick way to set a paragraph's 
alignment without using the menus.

To change a paragraph's alignment:

Select the desired paragraph or paragraphs in your publication.

Click on an alignment button on the control strip. The button will change from grey to white to show that it 
is the current alignment for the selected paragraph(s).

Left Alignment. Paragraph is aligned on the left-hand side and ragged on the right.

Center Alignment. Paragraph is aligned from the center, left and right-hand edges are ragged.

Right Alignment. Paragraph is aligned on the right-hand side and ragged on the left.

Justified. Paragraph is aligned on both left and right-hand edges.

You may also change a paragraph's alignment from the Paragraph... menu in the Text menu.



Publication Basics

Page Layout Tools

Rulers and Guides

Templates

Master Pages

Styles

Working With Text

Text Frames

Importing Text

Tabs and Indents

Fonts

Exporting Text

Working With Objects

Object Frames

Importing Pictures

Resizing Graphics

Cropping Graphics

Picture Catalog

Additional Topics

Utilities

Clipboard

OLE



Rulers and Guides

Rulers and guides are two key tools for smooth page layout. Guides are blue, horizontal and vertical non-
printing lines that you can position anywhere on you page to help you position text and graphical 
elements. Rulers also provide a way to quickly align multiple text and graphical elements, as well as an 
accurate measure for items on your page.

To make the Rulers visible, you must select Rulers Visible from the Preferences... dialog box. To show 
guides, make the rulers visible and click on either the horizontal or vertical ruler with your mouse. If you 
hold the left mouse button, you can move the guide around your page. Release the mouse button when 
you have the guide in the desired location.

To make frames and graphics align automatically, use the snap to options in your Preferences... menu.

See also:

Preferences...



Templates

Templates provide a framework upon which to build your publication. Since they provide all the 
information a publication needs    from the number of columns on a page, to the typeface and attributes of 
each paragraph style    templates are an excellent time-saving tool for publications that you create 
frequently.

There are a number of pre-built templates included with Publisher, but you can create your own by 
creating a publication and choosing Save As... from the file menu and choosing Template from the List 
Files of Type window.

When you start a new publication, Publisher allows you to select a template to work with. You can also 
use the Template Catalog to view small representations of the available templates.

When creating a publication template, remember to place repeating elements such as headers, page 
numbers and ruling lines on the Master Page so that they appear on every page of the publication 
automatically.

See Also:

Save As...

Template Catalog

Master Page



Master Pages

Master Pages are non-printing, "underlying" pages where you place elements that you would like 
repeated throughout the publication in the same postion. Use the Master Pages to set up items like page 
numbers, ruling lines, headers and footers.

You can hide master page objects on a page by using the "Use Master Objects for Page #" option.

See Also:

Master Menu Commands

Page Numbers

Use Master Objects For Page #



Styles

Styles are used to ensure consistency of text formatting throughout a publication. Formatting individual 
text blocks can lead to differences in paragraph spacing, typefaces, and font styles. Using styles ensures 
that all the text will be consistently formatted.

For the greatest efficiency, you should define styles before you import or add your text. This will help 
speed the formatting of your publication. All new text in a publication is automatically assigned the Body 
Text style. To assign a new style, place the text cursor in the paragraph you want to change and either 
select a new style from the window above the control strip, or from "Apply Style..." in the Text menu.

To create a new style, pick "Define Styles..." from the text menu.

See Also:

Apply Style...

Define Styles...



Text Frames

Text frames act as place holders for words in your publication. Before you can type or import text into your
publication, you must create a text frame to hold it. To create a text frame, select the text frame tool from 
the control strip, or "Create New Frame" from the Object Menu, hold the left mouse button, and drag your 
mouse to create to create a frame of the desired size. For precise sizing and positioning of a text frame, 
use the "Snap to Rules" and "Snap to Guides" options in the Preferences... dialog box.

Text frames may also be linked to make a large document flow from one frame into the next. To link 
frames, use the Link tool on the control strip or choose "Link Text Frames..." from the Object menu.

See Also:

Create New Frame

Importing Text

Link Text Frames



Importing Text in Publisher

Publisher will accept text files created by most major word processing applications. For a complete list of 
supported text formats, see your manual or the "Import Text" dialog box under the File menu.

If you do not use a word processor that is directly supported by Publisher, check the word processor's 
documentation to see if it can save files in an alternate format supported by Publisher.

To import text into a publication, you must create a text frame and place the text cursor in that frame.

See Also:

Importing Text Commands

Text Frames



Tabs and Indents

Tabs and Indents are a useful and powerful formatting tool in Publisher. Tabs can have a number of 
alignments and positions associated with them. Indents allow you to set paragraph alignment and effects 
such as hanging indents.

Publisher automatically sets up tabs every half-inch. The tabs settings are represented by arrows below 
the ruler. They are only visible when a text frame is selected. To change the tabs settings, you can click 
on one of the tab arrows below the ruler and drag it to a new location. Alternatively, you can select the tab
setting from the Paragraph option of the Text menu.

Indents can be set for a single paragraph, multiple paragraphs, or for an entire style. To set indents, select
Paragraph..., or Define Styles... from the Text menu. You can also change indents for a paragraph from 
the ruler. Indents are represented as two small triangles on the ruler bar. As with the tab arrows, these are
only visible when a text frame is selected. The triangle on top represents the indent for the first line in the 
selected paragraph. The lower triangle is the indent for the entire paragraph. To change the settings for 
the first line or the whole paragraph, simply click on the desired triangle and drag it to the new position 
with your mouse.

See Also:

Paragraph...

Define Styles...



Fonts

Publisher provides you with several ways to change the font formatting of text. For speed formatting, 
there is the control strip, for selective formatting there is the Character option in the text menu, and for 
formatting across a publication, there is the Define Styles... option.

To quickly change the font formatting, use the text cursor tool to highlight the text and pick a new 
typeface, font style and/or point size from the control strip. The same thing may be accomplished by 
highlighting the text and selecting Character... from the Text menu.

To change the text formatting for a style, select Define Styles.. from the Text menu, choose the style 
whose font formatting you want to change, and select "charater" from the dialog box. You may then 
change the typeface, point size and font style. The new font formatting will be applied to all text tagged 
with that style in your publication.

See Also:

Character...

Define Styles...



Exporting Text

Publisher provides the ability to export text from a publication into one of two text formats useable by 
virtually any word processor or text editor. Publisher will export text as ASCII text or Rich Text Format 
(RTF).

To export text from a publication, place your text cursor in the frame with the desired text and choose 
Export Text... from the File menu.

See Also:

Exporting Text Commands



Object Frames

Object Frames act as place holders for graphics in your publication. There are two types: Picture Frames 
and OLE Frames. Picture Frames hold graphics that are static, that is, once you place a picture in the 
frame, it does not change. OLE Frames contain pictures that are hot-linked via Object Link Embedding 
(OLE) to the application that create the picture. Thus, when you double-click on a linked object, the 
application used to create the object will open with that object ready to edit. If you make changes to the 
object, they will utomatically appear in your publication.

Before you can import a graphic or picture into your publication, you must create a Picture or OLE Frame 
to hold it. To create a Picture Frame, select the Picture Frame tool from the control strip, or "Create New 
Frame" from the Object Menu, hold the left mouse button, and drag your mouse to create to create a 
frame of the desired size. To create an OLE frame, use the OLE Object Frame tool on the control strip, or 
the Create New Frame... option in the Object menu.

OLE Frames may also contain pictures that are hot-linked via Object Link Embedding (OLE) to the 
application that create the picture. Thus, when you double-click on a linked object, the application used to 
create the object will open with that object ready to edit.

For precise sizing and positioning of a text frame, use the "Snap to Rules" and "Snap to Guides" options 
in the Preferences... dialog box.

See Also:

Create New Frame

Importing Pictures

Using OLE



Importing Pictures

Publisher offers two primary ways to add pictures and graphics to your publication    from a file, or via the 
clipboard. To add a picture, select the Picture (or OLE) frame tool from the control strip, or the Create 
New Frame option from the Object menu. Publisher will prompt you for a picture source (i.e., file or 
clipboard) and allow you to create a frame for the selected picture.

You may also paste a picture into a picture frame with the Paste Object or Paste Link options in the Edit 
menu.

See Also:

Paste Object

Paste Link

Object Frames

OLE



Resizing and Cropping Graphics

Pictures and graphics in a publication can be resized by dragging one of the nodes of an object frame 
until it is the size and shape you want. To avoid distorting the image, hold down the [Shift] key while 
dragging the frame node. This will keep the image's proportions the same while resizing the picture.

To crop a picture, select the frame holding the object you want to crop and pick the cropping tool from the 
control strip, or Crop From... in the Object Information... option under the Object menu. Resize the frame 
to include only the portions of the picture you want to appear

Cropping the picture does not actually change the picture. It merely reduces the size of a picture by hiding
the unneeded parts. You can restore or recrop the object at any time.

See Also:

Create New Frame

Crop From...



Using the Picture Catalog

The picture catalog is a unique Publisher utility that allows you to organize and preview pictures for use in
a Publication. This feature creates and maintains one or more catalogs of pictures you use frequently. 
Picture catalogs can consist of PCX, BMP, TIF, WMF, CLP, TGA, WPG, or GIF images. To use the Picture 
Catalog, Select Picture Catalog... from the Utilities menu (Alt U, P).

You can also access Picture Catalog functions from the Picture dialog box that appears when you create 
a picture frame.

A picture catalog will display the images in the catalog, along with the file name of the currently selected 
picture. If the catalog contains more pictures than can be displayed at once, choose a picture from the 
Files list box, or use the scroll bar at the bottom of the screen.

To add to an existing catalog, or to create a new catalog, select Picture Catalog from the Utilities menu. 

See Also:

Picture Catalog

View Picture Catalog



Utilities

PFS:Publisher provides a number of advanced text editing and publication organization features. Under 
the Utilities menu there is a spell checker and thesaurus that can be used on text in the publication much 
as a spell checker and thesaurus are used in word processors.

For longer and more complex documents, Publisher also offers the ability to automatically generate a 
table of contents and index. To use these two features, the text that is to appear in the table of contents or
index must be specially tagged. See the Generate Table of Contents... and Mark Index Entry... options in 
the Utilities menu.

See Also:

Utilities Menu Commands

Spell Checker

Thesaurus

Table of Contents...

Index Entry...



Using the Clipboard

The Clipboard is a temporary storage area in Windows that holds text or graphics placed there with 
Publisher's (or any other Windows application) Cut or Copy command. You can copy text and pictures 
from other applications and paste them into a publication using the application's Cut, Copy and Paste 
commands.

When using the clipboard to paste text into a publication, copy the text to the clipboard from your source 
application (word processor, etc.), place your text cursor in a Publisher text frame and use the Paste 
option (or Shift-Insert) in the Edit menu.

If you want to use the clipboard to paste an object into a publication, you have three options. To paste a 
static picture (one that is not linked to anything else), copy the object to the clipboard from your source 
application (paint program, drawing program, etc.), and either click on the picture frame tool on the object 
mode control strip and choose clipboard as the source, or select Paste Object from the Edit menu. To 
paste a linked picture (one that is hot-linked via OLE to the application that created it), follow the same 
steps as above, using the Paste Link option.

See Also:

Paste Object

Paste Link



OLE

OLE (pronounced "O-lay") is an acronym for Object Link Embedding. An object (which can be a picture, 
graph, chart, or sound) brought into Publisher via OLE remains "linked to the applications that created it. 
Thus, when you double-click on a linked object you have placed in a publication, the application used to 
create the object will open with that object ready to edit. If you make changes to the object, they will 
automatically appear in your publication. The same is true if you modify an object in another application 
and then open the Publisher document in which that object has been embedded. The changes to the 
object will automatically appear in your publication.

OLE is particularly useful for Publications that contain text and/or graphics that change frequently. For 
example, if you used Publisher to produce a menu for a restaurant, but wanted to change it daily for 
different specials, you could write the text in Microsoft Word for Windows, and import it into your 
Publication via OLE. From there on, to update the menu, all you would need to do is change the Word 
text file. Publisher's OLE links would detect the changes and automatically update the menu.

PFS:Publisher has powerful OLE capabilities, and allows you to link objects created in other applications 
that are recognized as OLE servers, for example:

Application OLE Object Type(s)
PFS:WindowWorks Tables and Graphs

Excel Graphs and Charts
WinWord Text and WordArt
MS Draw Drawings
Paintbrush Paintbrush pictures
Win 3.1 Multimedia Sounds

To create an OLE frame, use the OLE Object Frame tool on the control strip, or the Create New Frame... 
option in the Object menu.

See Also

Paste Link

Links...

Object

Create New Frame



Character Spacing Also called Kerning. The distance between characters. May be changed to 
improve appearance of characters at very large and very small sizes.



Clipboard A temporary storage area in Windows that holds text or graphics placed there 
with Publisher's (or any other Windows application) Cut or Copy command.



Control Panel Windows function that allows you to set up printers, connections, and other 
items.



Control Strip A menu bar with buttons for quick access to commonly used functions and 
commands.



Crop Reducing the size of a picture by trimming unneeded parts. You can restore or 
recrop the object at any time.



Font The complete set of characters in a typeface at particular point size (e.g., 12 
point Times New Roman). In desktop publishing a font may also be the complete 
set of characters for a typeface at any size (e,g., Times New Roman).



Frame A container created on a page to hold text or a graphic.



Gutter The empty space between columns on a page.



Leading Pronounced "led-ing". The space between lines, specified in points. Leading is 
measured from the baseline of one line to the baseline of the next line.



Master Page The underlying page where repeating elements such as page numbers, headers, 
footers, and special graphics are placed.



Object Graphical elements (e.g., pictures, graphs, etc.) either created with Publisher's 
drawing tools or imported into Publisher from other applications.



OLE Object Link Embedding.    A method of    linking an object (which can be a picture, 
graph, chart, or sound) in Publisher to the application that created it. 



Pica A typographical unit of measure. There are 12 points to a pica, and 6 picas to the 
inch.



Point A typographical unit often used to measure the size of a typeface. There are 12 
points to a pica, and 72 points to the inch.



Publication A PFS:Publisher document.



Scalable Font A typeface stored as an "outline" that can be scaled to any size "on-the-fly" by a 
software application or printer.



Story A text document either typed or imported into Publisher.



Style A collection of character and paragraph specifications (font, point size, indents, 
borders, leading, etc.) to which a name is assigned. Styles let you supply several 
specifications at once rather than choosing each one separately, so that you can 
easily duplicate the format and appearance of titles, body text, and other 
common elements in your publication.



Superscript A character positioned above the baseline.



Subscript A character positioned below the baseline.



Template A "framework" that provides pre-set text, graphics, paragraph styles, and page 
layout information for a publication.



Template Catalog A PFS:Publisher feature that allows you to preview and select from templates 
stored on your system.



Wrap Causing text to flow around a graphic rather than over it.



Dinosaurs are alive and well.



Glossary

Character Spacing Also called Kerning. The distance between charaters. May be changed to 
imporve appearance of characters at very large and very small sizes.

Clipboard A temporary storage area in Windows that holds text or graphics placed there 
with Publisher's (or any other Windows application) Cut or Copy command.

Control Panel Windows function that allows you to set up printers, connections, and other 
items.

Control Strip A menu bar with buttons for quick access to commonly used functions and 
commands.

Crop Reducing the size of a picture by trimming unneeded parts. You can restore or 
recrop the object at any time.

Font The complete set of characters in a typeface at particular point size (e.g., 12 
point Times New Roman). In desktop publishing a font may also be the complete 
set of characters for a typeface at any size (e,g., Times New Roman).

Frame A container created on a page to hold text or a graphic.

Gutter The empty space between columns on a page.

Leading Pronounced "led-ing". The space between lines, specified in points. Leading is 
measured from the baseline of one line to the baseline of the next line.

Master Page The underlying page where repeating elements such as page numbers, headers, 
footers, and special graphics are placed.

Object Graphical elements (e.g., pictures, graphs, etc.) either created with Publisher's 
drawing tools, imported into Publisher from other applications.

OLE Object Link Embedding. 

Panning Moving a cropped picture around within its frame.

Pica A typographical unit of measure. There are 12 points to a pica, and 6 picas to the 
inch.

Point A typographical unit often used to measure the size of a typeface. There are 12 
points to a pica, and 72 points to the inch.

Publication A PFS:Publisher document.

Scalable Font A typeface stored as an "outline" that can be scaled to any size "on-the-fly" by a 
software application or printer.

Story A text document either typed or imported into Publisher.

Style A collection of character and paragraph specifications (font, point size, indents, 
borders, leading, etc.) to which a name is assigned. Styles let you supply several 
specifications at once rather than choosing each one separately, so that you can 



easily duplicate the format and appearance of titles, body text, and other 
common elements in your publication.

Superscript A character positioned above the baseline.

Subscript A character positioned below the baseline.

Template A "framework" that provides pre-set text, graphics, paragraph styles, and page 
layout information for a publication.

Template Catalog A PFS:Publisher feature that allows you to preview and select from templates 
stored on your system.

Wrap Causing text to flow around a graphic rather than over it.



Open Picture 

Each time you open a publication containing pictures, Publisher accesses the pictures files to display the 
images within the publication.    If you change a picture file's name or disk location, Publisher will search 
for that file.    If Publisher can not locate the file, the Open Picture dialog box appears. If you do not supply
a picture file name to open Publisher displays a blank picture frame.    You may place a picture in the 
blank frame at any time.

File Name In this text box you can enter the name of the picture that you want to place in 
your publication.

If you select another other file type, enter the name of the picture file you want to 
select. You can also change the drive and directory from the Directories list box 
and then select the file from the Files list box.

List Files of Type Select the file type of the picture file you want to place into your publication.    
Publisher can open PCX, BMP, TIF, WMF, CLP, TGA, WPG, or GIF images.

Directories / Drives Select the directory and drive of the picture file you want to open from the 
Directories and Drives list boxes and click on OK. All files with the name or type 
you specified appear in the File Name list. Select a file from the list.    If the file 
you want is not in the list, specify a different drive or directory.



Add to Template Catalog

The Add to Template Catalog dialog box allows you to specify to which the catalog you want to save the 
current template.    

Template Lists the name of the current template.

Description This text box allows you to write a brief description of the template.    The 
description you write will appear when you view the catalog and select the 
template.

Catalog Name Lists the name of the selected catalog.    Choose the catalog you want to save the
current template to from this list box.    

To save the template into a new catalog, type a new name into the Catalog Name
box.    When you select OK, Publisher will indicate that the new name does not 
exist and wiwll ask if you want to create a new template catalog.




